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Introduction
MicroStrategy Web is a web-based query and reporting tool. Through the internet, staff members can run reports and view the results in clearly formatted tables or graphs. This document shows you how to log in and get started with MicroStrategy Web.

How do I obtain access to Microstrategy?

In order to gain access to Microstrategy please email eagsupport@ucc.ie , after you have done this you will be supplied with a username and password.

Getting Started with MicroStrategy Reporting Tool 

Note: You can access MicroStrategy web from any computer that can run a browser.

To Start MicroStrategy Web do the following:

In a browser, enter the URL of UCC’s MicroStrategy Web site.

http://seville.ucc.ie/MicroStrategy/asp/Main.asp
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Logging In

After you have done this you will be presented with a log in screen as follows:
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In order to log into MicroStrategy Web

 1. Enter your UserName and  Password
 2. Click Login.
You will then be presented with the ‘projects’ you have access to, the project which you are interested in is UCC DW so in order to access this you simply click on UCC DW.
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Changing your Password

To change your password:

1. Click on Preferences at the top right of the page.
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The Preferences page displays. Links on the left side of the page direct you to preferences related to different features. 

2. Click on the Change Password link on the left hand side.

3. Old password - Enter your old password (the password you are changing). 

4. New password - Enter your new password. 

5. New password verification - Enter your new password again 

6. Click on the Change Password button.
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Home Page

Once you have logged in The Home Page appears, from there you can open folders containing reports in order to view and work with them.
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Shared Reports contains reports that are accessible by multiple users.

How Reports are grouped

At present all reports are organised in a standardized folder structure. Each set of reports are stored in a folder relating to their content. Reports are currently divided into their subject matter. All student related reports are situated in the Students Folder.
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These are further divided into the following categories; each category provides a suite of reports. 

[image: image10.png]Rk

Applications and Admissions
Ouwner: Hackett, Sancra

Modified: 05/02/09 16:37:43
‘Set of Student Applications and Adissions analysis reports. These reports are based on data n TS (and not based

on CAG fies).

FTE
Owner: Hadett, Sandra
Modified: 26/03/09 16:11:16
Set of Student FTE Analysis reports.

Graduates
Owner: Hadett, Sandra

Modified: 05/01/09 12:15:28
‘Set of UCC Gradautes analysis reports.

Snapshots
Ouner. Oisulivan, Bary (Computer Centre)
Modified: 26/02/03 03:15:19

List of reports based on point i time n acaderic year - e.g. Dec 01,

FTE
Owner: Hadett, Sandra
Modified: 26/03/09 16:11:16
Set of Student FTE Analysis reports.

Headcount
Owner: Hackett, Sandra

Modified: 31/03/09 15:52:52

Set of Student Headcount analysis reports.




All Application and Admissions based reports are located in the Applications and Admissions folder; All the FTE based reports are located in the FTE folder and so on and so forth.

The image below shows the suite of reports associated with Application and Admissions.
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Note: 
Headcounts and FTEs include historic data based on the 1st of March and current academic year data which is refreshed on a nightly basis.

The Snapshots suite of reports enables you to see how student data looks at a particular point in time, snapshots are taken of data at intervals e.g. 1st December , these reports will then be based on this date.

Opening a Report in MicroStrategy Web

1. Select Shared Reports.
2. Click into the Student folder. 

Once you have selected the appropriate folder, the reports in the folder appear listed as follows.
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Running a Report 

1. Simply click on any report to run it and see the data results.

Wait Page

The Wait page is displayed if results are not immediately returned when you request the execution of a report. The Wait page contains the report name and its current execution status. When execution is complete, the Results page automatically replaces the Wait page.
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Refreshing the wait Page

To refresh the Wait page

1. Click the Check Status Again button.
Cancelling execution

To cancel a report,
1. Click Cancel on the Wait page to return to the folder from which you made the     request.
The image below shows a report after execution
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Page By 

What is Page- By?

Page-By enables you to select and display subsets of your report results as separate pages. This is very useful for extremely long reports where you have to scroll so see all the data.

Suppose you have a report CAO Applicants - % first Preference by Course .Notice only the figures for 2008/09 are showing 

[image: image56.png]


[image: image15.png]My

UCCDW > Shared Reparts > Students > Applcations and Admissions > AADDO1:CAO Applications -9 First Preference by Course

4412 of2pages b W

0 15t Pref

Arts, Celtic Studies and Social Sciences CK101  BA . Py
CK102  BSOC Social Science .
CK103  BMUS Music .
CK104 BAMUS BA (Arts Music)
CK106  BAP BA (Applied Psychology) . 3
CKi11  BAEC BA (Early Childhood Studies) 3
CKi12  BDTS BA (Drama and Theatre Studies) 3
CK114  BYCW  BSocSc (Youth & Community Work) <
cK115  BSW Social Work

CK116  BEDSS _BEd Sports Studies & Physical Education
Total ey . -





By using the drop down menu you can select previous academic years, this enables you to view the CAO Applicants - % first Preference By Course for previous years. 

Simply Use the drop down box to select the specific year you wish to see on the 
report.
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The report now shows data for 2007/08
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Report Prompts

Some reports may contain prompts. A prompt is a question presented to the user who runs the report. Depending on the answers the user provides, the report brings back and displays different data from the data source.

For example, a Student Headcount report may prompt you for specific year 

and college before executing.

The following image shows one example of a prompt that appears when a prompted report is executed. You can choose one or more answers from the centre pane, in this example its years and colleges.
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In order to select your desired academic year simply double click on it.

Likewise to select your desired college double click on it.

Once you have made your selections you will see that they will display in the selected box as follows:
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Note: If you accidentally selected something from the list and you wish to deselect it just double click on it.

To run your reports simply do the following: 

1. Click on the [image: image20.png]


 button.

Note:  multiple years and colleges can be selected by just double clicking on them.

As some prompts may consist of lists that have of thousands of elements it is possible to do a search first before you select from the prompt list. 

For example if you want to run a report on a particular department then 

1. Type in the departments name 

2. Click on the magnifying glass

 This will search the list for the department you have entered into the search field.
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As can be seen from the diagram this will narrow your selection considerably.

Note: As the search is case sensitive you may need to uncheck match case
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In order to select Faculty of Arts just double click on it.

Wildcards can also be used to reduce the number of values that are displayed. Use the * to substitute any number of characters.
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You will see that this has also narrowed the search considerably also, only returning departments beginning with Foo.
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Once again to select your department just double click on it.

Report Types

You can view a report from different perspectives, depending on the type of work you need to perform.

To see a report in Grid view

1. From the Home menu select Grid by clicking on it.


[image: image25]
The image below shows a standard grid report in MicroStrategy. This is the most commonly used mode.
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You can also display report data as a graph by using Graph View.

To see a report in Graph view

1. From the Home menu select Graph 
The image below shows the same report in graph view. 
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A report can also be shown Grid and Graph view, by clicking Grid 

And Graph.
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Drilling 

Drilling enables users to explore data beyond the data immediately visible on a report. You can drill through a report to analyze data that is closely related to the original report data.

Any object on a Microstrategy report that has a drill attached to it is easily identifiable as it is underlined. 
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To Drill on an object 

    1. Click on it  



When you hover over the figure it shows you what exactly it is drilling to. 

An object can have more than one drill associated with it.

If you right click on the object you will see a list of all drills that can be carried out.

From the diagram below you can see that you can drill By Module but also by Student 
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The drill now opens in the same window so all you need to do to get back to the original report is press the back button.
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Printing and Exporting Report data

Printing Report Data

1. Click any report to execute it.

2. Click the Print icon at the top of the page. 

 The Print Options page opens. 

Select suitable options for printing your report.  
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3. Click Show Printable Version at the bottom of the Print Options page to preview your printing.   
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Anything within the lines (print area) will be printed; anything outside of the print area will not print. 

4. To print the report, use the browser's print capabilities.
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(If you have Internet Explorer Version 6 you will need to Click the File menu on your browser and select Print)
Note: If you would like to change the appearance of the printable version before printing, click the browser's Back button to return to the Print Options page. There you can change number of rows and columns per printed page.

More on the Print Options
Page Header and Footer: You can use headers and footers on all your reports.
Select Edit Custom Settings to access the Header/Footer Editor. You can specify what text to print in the left, centre, and right portions of the page's header and footer. You can simply type this text or insert fields specific to the report by choosing macros from the Insert Auto-text drop-down list at the top of the page. 
Scaling: Adjust the amount of the report's content (and thus, the size of the font) that prints on a page from the following scaling options:

Adjust font to __% of original size: Manually set the percent to adjust the font on a page. 
Fit to page: Specify whether the page is adjusted for All columns, All Rows, or both. 
Print cover page with filter details: Print the filter details of a report on a separate page. The filter details are placed before the contents of the report.
Select Show advanced options to view the following options:
[image: image35.png]Paper size: [Letter 8.5 x 11°

Mergns (Inches)

Maximum header size (Inches):
Maximum footer size (inches):

] Embed onts

oo notprompt me agan.




Paper size: Select the paper size on which to print a report. As Microstrategy is an American application you will need to change the paper size to A4.
Margins (Inches): Set the top, left, right and bottom margins. For reports to print correctly, these margin settings, the margin settings in the browser's File, and the Page Setup option must match. This is only applicable if PDF printing is disabled. The default values for all of them is 0.75 inches. 

 

Click OK to save your changes and close the dialog box. 

***Please note ******

When you go to print your report you may see the following message: 
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If this occurs simply click on the message and click Temporarily Allow Pop ups
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Exporting Report Data

It is also possible for you to export a report to applications such as Excel and PDF.

After your report has been executed, to export to Excel, CSV, HTML, PDF or Plain Text do the following:

1. From the Home menu, choose Export or simply click Export icon.
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The Export Options dialog box opens.

 2. Select you desired export option.


 3. Click on the Export Button

You will be prompted then to open or save the report. It is best if you then save the report to your computer.
Exporting to Excel 
In order to export to excel, we recommend that you export to Excel with formatting

1. Click Home or Click on the Export  icon 
2. Click Export

3. Click Excel with formatting

     The Export Options dialogue box will pop up 
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Excel: If you are exporting to Excel, you can set the following options:

To include filter information in the exported report, select the Export filter details check box.

Select the Expand all page-by fields check box. 

Select the Place each page on a separate sheet check box to place each page-by field on a separate worksheet.

This will put every option in the page- by field on a separate sheet as follows:
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Last 5 academic years have been placed on the page- by

If you wish to edit the report itself you will have to save it to your computer.
Exporting to PDF 
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New Back and Forward button on Microstrategy 9
A new aspect of Microstrategy 9 is the introduction of the new back and forward buttons, these buttons will allow you to navigate through the different pages without seeing the Page Expired Message. 
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Use the Back [image: image44.png]


and Forward [image: image45.png]


buttons on the MicroStrategy Web toolbar to navigate back and forth among MicroStrategy Web pages you have visited:   

This feature is similar to the Back and Forward buttons in browsers, but your browser's Back and Forward buttons may return a Page Expired message. So please use this feature instead of your browsers back and Forward.
Navigating through folders

In MicroStrategy Web, you browse through project folders to locate reports.
While you are navigating through MicroStrategy Web, a path appears at the top of the page showing the project you logged into, and any folders you subsequently opened. An example is shown below:
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1. In order to return to your Home Page at any stage just click on the Home Page icon.
[image: image47.png]Shredrepors y Repors
W (A





2. To navigate to the folder immediately above your current location, click the  Return To icon [image: image48.png]


.

3. To go to any folder in the path, click the folder's name. 
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Logging Out 

To log out of a project:

1. Click the Logout link at the top right hand of the page. 
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 A logout dialog page opens.
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To log back in to Web, Click Login.

This prompt is optional.








This prompt must be answered before the report executes
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You can choose to print the entire report or the portion displayed on the screen by using this drop menu.
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